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Abstrak- Internet of Things merupakan suatu penemuan yang 

sangat bermanfaat khususnya bagi dunia Pendidikan. Demikian 

juga untuk sistem kendali berbasis Internet of Things (IoT) 

terutama sensor dan aktuator dapat dijadikan  area penelitian 

yang berkembang pesat dalam beberapa tahun terakhir. 

Proposal ini bertujuan untuk merancang dan 

mengimplementasikan sistem kendali berbasis IoT yang 

menggunakan modul ESP8266. Pengembangan perangkat lunak 

dilakukan menggunakan platform pemrograman yang sesuai, 

seperti Arduino IDE atau PlatformIO. Kode program ditulis 

untuk mengatur koneksi Wi-Fi, integrasi dengan sensor dan 

aktuator, serta logika kendali berbasis kondisi yang diinginkan. 

sistem akan diimplementasikan di lokasi yang ditentukan dan 

disiapkan untuk pemantauan dan pengendalian jarak jauh 

melalui antarmuka pengguna yang sesuai. Sistem yang dibangun 

menggunakan NodeMCU ESP8266 sebagai pengendali utama 

dan komunikasi IoT melalui platform yang dipilih terbukti dapat 

bekerja secara stabil dan efisien pada saat pengujian dengan 

menunjukkan bahwa alat ini dapat berfungsi dengan baik 

menggunakan sensor dan aktuator yang digunakan, termasuk 

pemantauan data sensor secara real-time dan respon aktuator 

yang tepat. Dengan demikian, alat ini layak digunakan sebagai 

media pembelajaran untuk praktikum sensor dan aktuator dan 

IoT. Pada tahap pengujian alat digunakan aplikasi blynk untuk 

mengendalikan motor dan motor dapat digerakan melalui 

aplikasi Blynk. Pada pengujian sensor DHT11, sensor dapat 

dimonitor dengan hasil awal suhu ruang 29,80oC dengan 

kelembaban 67% pada aplikasi ThingSpeak. 

 

Kata-kata kunci: Internet of Things, NodeMCUESP8266, Arduino 

IDE, sensor, aktuator 

 

I. PENDAHULUAN 

 

Dalam konteks pendidikan teknologi dan teknik, 

pembelajaran praktis tentang konsep-konsep seperti Internet of 

Things (IoT) sangat penting terutama yang terintergrasi 

dengan Sistem kendali. Mahasiswa perlu memahami 

bagaimana mengembangkan sistem IoT yang efisien 

menggunakan teknologi yang tersedia saat ini. Dalam hal ini, 

penggunaan ESP8266 sebagai modul Wi-Fi dalam 

pengembangan sistem kendali berbasis IoT yang mudah untuk 

dipahami dan diterapkan dalam mata kuliah yang mereka 

pelajari. Kurangnya sumber daya yang jelas dan terstruktur 

dalam bentuk media ajar atau alat ajar dapat menjadi hambatan 

bagi pendidik dan pembelajar. Oleh karena itu, pengembangan 

media ajar atau alat ajar yang berfokus pada perancangan dan 

implementasi sistem kendali berbasis IoT menggunakan 

ESP8266 menjadi penting. 

Media ajar atau alat ajar ini akan membantu 

memperkenalkan konsep-konsep dasar IoT khususnya pada 

system kendali atau sistem kontrol yang terdiri sensor dan 

aktuator. Dengan memberikan panduan langkah-demi-langkah 

dalam penggunaan ESP8266 sebagai platform IoT. dalam 

merancang dan mengimplementasikan solusi IoT.  

Dengan menyediakan media ajar atau alat ajar yang 

mudah diakses, diharapkan bahwa mahasiswa dan dosen 

praktikan dapat memberikan pendekatan pembelajaran yang 

lebih efektif untuk materi mengenai IoT ini, dosen dan 

mahasiswa dapat mengembangkan keterampilan yang 

diperlukan untuk menghadapi tantangan dalam dunia nyata 

terkait dengan IoT dan teknologi terkait.  

 Tujuan dari penelitian ini adalah untuk 

mengembangkan dan mengimplementasikan alat bantu ajar 

berbasis sensor dan aktuator yang terhubung melalui Internet 

of Things (IoT), yang dirancang untuk mempermudah 

mahasiswa dalam memahami konsep praktikum terkait sensor 

dan kontrol aktuator. Alat ini memungkinkan mahasiswa 

untuk mengamati dan mengontrol proses secara real-time dari 

jarak jauh melalui aplikasi IoT, sehingga mereka dapat 

mempelajari respon sistem terhadap perubahan input secara 

langsung dengan menggunakan aplikasi yang menggunakan 

platform Iot. Dengan adanya alat bantu ini, diharapkan proses 

belajar menjadi lebih interaktif, praktis, dan mendalam, 

meningkatkan kompetensi mahasiswa dalam memahami 

teknologi sensor, aktuator, dan jaringan IoT. 

 

 

 

II. TINJAUAN PUSTAKA 

  

Hemat energi dan efisiensi dari biaya energi listrik 

penerapan IoT dalam penerapannya dalam kendali lampu 

rumah jarak jauh dengan berbasis NodeMCU[1] Kemajuan 

pesat dari teknologi dan internet bukan hanya sebatas pada 

jejaring WEB melalui browsernya, tetapi juga hampir dari 

segala aspek kehidupan tidak lepas dari kendali internet. 

Internet of Thing(IoT) mengacu pada suatu jaringan yang 

menghubungkan berbagai perangkat dalam dunia nyata 

dengan protocol yang berbeda – beda [2] .Pada penelitian 

lainnya IoT di rancang untuk memonitoring pemakaian daya 
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listrik pada rumah kos, sehingga memudahkan pemilik kos 

untuk  memonitoring penggunaan daya listrik dari para 

penyewa[3]. 

Penelitian lain yang sejenis yang menggunakan 

mikrokontroller [4]. Menggunakan ESP32 untuk menunjang 

pembelajaran pada praktikum mikrokontroller dan 

mikroprosessor sehingga lebih efektif dan efisien. 

 

A. Internet of Things 

IoT adalah singkatan dari internet of things yang mana 

memiliki arti internet merupakan segalanya. Dalam hal ini bisa 

disimpulkan bahwa internet berperan penting dalam segala 

aktivitas dilakukan. IoT adalah salah satu dari sekian banyak 

teknologi yang dikembangkan untuk menghadapi era digital 

seperti sekarang dan dapat memudahkan masyarakat dan 

pengguna ketika memakainya serta dapat mengatasi kesulitan 

berbasis digital tersebut. 

IoT merupakan sebuah konsep yang bertujuan untuk 

memperluas manfaat dari konektivitas internet yang 

tersambung secara terus menerus yang memungkinkan untuk 

menghubungkan mesin, peralatan, dan benda fisik lainnya 

dengan sensor jaringan dan aktuator untuk memperoleh data 

dan mengelola kinerjanya sendiri, sehingga memungkinkan 

mesin untuk berkolaborasi dan bahkan bertindak berdasarkan 

informasi baru yang diperoleh secara independen. Internet Of 

Things atau sering disebut IoT adalah sebuah gagasan dimana 

semua benda di dunia nyata dapat berkomunikasi satu dengan 

yang lain sebagai bagian dari satu kesatuan sistem terpadu 

menggunakan jaringan internet sebagai penghubung. misalnya 

CCTV yang terpasang di sepanjang jalan dihubungkan dengan 

koneksi internet dan disatukan di ruang kontrol yang jaraknya 

mungkin puluhan kilometer. atau sebuah rumah cerdas yang 

dapat control lewat smartphone dengan bantuan koneksi 

internet. pada dasarnya perangkat IoT terdiri dari sensor 

sebagai media pengumpul data, sambungan internet sebagai 

media komunikasi dan server sebagai pengumpul informasi 

yang diterima sensor dan untuk analisa. [5] 

Pada penelitian lainya Internet Of Thing dalam 

pembelajaran masih terdapat kesenjangan dan minimnya 

inovasi yang menghambat pedagogi dalam memahami 

pembelajaran, dari hal tersebut diperlukan inovasi agar 

mahasiswa dapat memperlajari secara mendalam mengenai 

Internet of things[6], [7] 

 

A. Mikrokontroler 

Mikrokontroler adalah sebuah sistem komputer yang 

seluruh atau Sebagian elemennya dikemas dalam bentuk 1 

chip IC, sehingga sering disebut single chip microcomputer. 

Mikrokontroller juga merupakan sistem computer yang 

mempunyai satu atau beberapa tugas yang sangat spesifik 

yaitu sebagai input, proses dan output. Pada penelitian ini 

digunakan 2  jenis mikrocontroler yaitu Arduino UNO [8] dan 

mikrocontroller NodeMCU ESP 8266 sebagai kendali dan 

pengirim datanya. 

B. NodeMCU ESP8266 

Mikrokontroller NodeMCU merupakan pengembangan 

Node MCU ESP8266 dengan modul ESP-12E yang berisi chip 

ESP8266 yang memiliki mikroprosesor Tensilica Xtensa 32-

bit LX106 RISC. Mikroprosesor ini mendukung RTOS dan 

beroperasi pada frekuensi jam 80MHz hingga 160 MHz yang 

dapat disesuaikan. NodeMCU memiliki RAM 128 KB dan 

memori Flash 4MB untuk menyimpan data dan program. 

Kekuatan pemrosesannya yang tinggi dengan Wi-Fi / 

Bluetooth bawaan dan fitur Deep Sleep Operating 

menjadikannya ideal untuk proyek IoT. 

NodeMCU dapat ditenagai menggunakan jack Micro 

USB dan pin VIN (External Supply Pin). Ini mendukung 

antarmuka UART, SPI, dan I2C. Gambar 1 merupakan bentuk 

dari  Modul ESP32[9] 

 
Gambar 1.  Modul NodeMCU ESP8266 

 

C. Pemrograman NodeMCU ESP8266 dengan Arduino 

IDE 

Board NodeMCU dapat dengan mudah diprogram 

dengan Arduino IDE karena mudah digunakan. Memprogram 

NodeMCU dengan Arduino IDE tidak akan memakan waktu 

5-10 menit. dibutuhkan Arduino IDE, kabel USB, dan papan 

NodeMCU itu sendiri.  

 

 
Gambar 2.  Konfigurasi NodeMCU ESP32 

 

D. Sensor dan Aktuator 

Sensor adalah jenis tranduser yang digunakan untuk 

mengubah besaran mekanis, magnetis, panas, sinar, dan kimia 

menjadi tegangan dan arus listrik. Sensor sering digunakan 

untuk pendeteksian pada saat melakukan pengukuran atau 

pengendalian. Tranduser merupakan sistem yang melengkapi 

agar sensor tersebut mempunyai keluaran sesuai yang kita 

inginkan dan dapat langsung dibaca pada keluarannya. Sensor 

juga merupakan alat untuk mendeteksi/mengukur sesuatu, 

yang digunakan untuk mengubah variasi mekanis, magnetis, 

panas, sinar dan kimia menjadi tegangan dan arus listrik.  

Pada sistem pengendali dan robotika, sensor 

memberikan kesamaan yang menyerupai mata, pendengaran, 

hidung, lidah yang kemudian akan diolah oleh kontroler 

sebagai otaknya. pada teknik pengukuran dan pengaturan 

secara elektronik berfungsi mengubah tegangan fisik menjadi 

besaran listrik yang proposional. Misalnya temperatur, cahaya, 

gaya, kecepatan putaran 

Sensor dalam teknik pengukuran dan pengaturan ini 

harus memnuhi persyaratan-persyaratan kualitas yakni: 
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1. Linieritas konversi harus benar-benar proposional, jadi 

karakteristik konversi harus linier. 

2. Tidak tergantung temperature, Keluaran inverter tidak 

boleh tergantung pada temperatur disekelilingnya, 

kecuali sensor suhu. 

3. Kepekaan sensor harus dipilih sedemikian, sehingga 

pada nilai-nilai masukan yang ada dapat diperoleh 

tegangan listrik keluaran yang cukup besar. 

4. Waktu tanggapan adalah waktu yang diperlukan keluaran 

sensor untuk mencapai nilai akhirnya pada nilai masukan 

yang berubah secara mendadak. Sensor harus dapat 

berubah cepat bila nilai masukan pada sistem tempat 

sensor tersebut berubah. 

 

E. Modul  KEYES HY- M-302  

KEYES multifungtion Shield V1 adalah papan 

pembelajaran berbasis Arduino, Namun dapat digunakan juga 

untuk NODEMCUESP 32 dengan mengetahui spesifikasi dari 

alat ini, Modul ini sudah terhubung dengan masing – masing 

pin sehingga memudahkan penggunaannya. Gambar modul 

seperti pada Gambar 3 berikut. 

 

 
Gambar 3 . Gambar Modul Sensor HY-M302 

 

 

Spesifikasi: 

• Mampu menggabungkan shield dengan pengontrol 

utama yang ada di pasaran, seperti Arduino UNO R3, 

MEGA2560, Duemilanove, Leonardo dan 

MEGA2560 

• Dua lampu indikator LED 3mm untuk menunjukkan 

kondisi kerja program untuk memodulasi program 

dengan mudah (D12= merah, D13= biru) 

• Sakelar tombol 2 saluran untuk mewujudkan 

eksperimen interupsi eksternal (sw1=D2, sw2=D3)  

• Satu tombol Reset  

• Modul sensor suhu dan kelembapan DHT11 

mendeteksi suhu dan kelembaban (data=D4) 

(gunakan perpustakaan dht11.h) • Satu potensiometer 

rotasi, berfungsi sebagai input analog (analog A0 pin) 

• Satu modul buzzer pasif untuk alarm dan 

mengeluarkan suara (pin D5) • Satu LED RGB penuh 

warna (pin PWM: D9, D10, D11)  

• Resistansi foto untuk mendeteksi intensitas cahaya 

(analog A1 pin) 

• Sensor suhu LM35D untuk mengukur suhu (pin 

analog A2) • Penerima inframerah 

• VS1838 untuk mendeteksi fungsi penerimaan IR 

dengan monitor rx Led1 (data masuk=D6) (gunakan 

perpustakaan IRremote.h)  

• 2 saluran 3 pin digital generik I/ Port O (D7, Vcc, 

GND / D8, Vcc, GND) 

• Port analog generik 1 saluran 3 pin (A3, Vcc, GND) 

• Satu port antarmuka IIC (GND, Vcc, SDA, SCL) • 

Satu port serial TTL (TXD, RXD, Vcc, GND) 

 

F. Aktuator 

Aktuator adalah bagian yang berfungsi sebagai 

penggerak dari perintah yang diberikan input, aktuator 

biasanya berupa piranti elektromekanik yang menghasilkan 

daya Gerakan.  Aktuator juga merupakan alat yang mengubah 

sinyal listrik menjadi gerakan mekanis digunakan 

sebagai proses lanjutan dari keluaran suatu proses olah data 

yang dihasilkan oleh suatu sensor atau kontroler. Motor DC 

Motor DC (Direct Current) adalah mesin listrik yang 

mengubah energi listrik arus searah menjadi energi mekanik. 

Prinsip dasar motor DC didasarkan pada interaksi antara 

medan magnet dan arus listrik yang mengalir dalam kumparan 

untuk menghasilkan gaya gerak yang dikenal sebagai gaya 

Lorentz. Ketika arus mengalir melalui lilitan dalam medan 

magnet, gaya ini menyebabkan rotor atau angker motor 

bergerak, menciptakan gerakan rotasi. 

Motor DC terdiri dari beberapa komponen utama seperti 

kumparan medan (field winding), angker (armature), 

komutator, dan sikat (brushes). Medan magnet yang 

dihasilkan dapat berasal dari magnet permanen atau 

elektromagnetik pada stator. Komutator bertanggung jawab 

untuk mengubah arah arus di dalam kumparan angker 

sehingga torsi tetap konstan selama rotasi. 

 

1. Jenis-Jenis Motor DC 

Motor DC umumnya dibagi menjadi beberapa jenis 

berdasarkan cara pengaturan medan magnetnya, yaitu: 

2. Motor Servo 

Motor Servo merupakan motor listrik dengan 

menggunakan sistem closed loop. Sistem tersebut digunakan 

untuk mengendalikan akselerasi dan kecepatan pada sebuah 

motor listrik dengan keakuratan yang tinggi. Motor servo 

digunakan untuk mengubah energi listrik menjadi mekanik 

melalui interaksi dari kedua medan magnet permanent.    

Motor berfungsi sebagai penggerak roda gigi agar dapat 

memutar potensiometer dan poros output-nya secara 

bersamaan.  Potensiometer atau encoder berfungsi sebagai 

sensor yang akan memberikan sinyal umpan balik ke sistem 

kontrol untuk menentukan posisi targetnya. Biasanya 

potensiometer pada motor servo digunakan dalam 

pengaplikasian sederhana seperti mobil remote kontrol. 

Sedangkan encoder bisa diaplikasikan pada motor servo 

industri.[10]  
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Gambar 4 . Motor servo 

 

III. METODE PENELITIAN 

 

Penelitian dilakukan di laboratorium Jurusan Teknologi 

Informasi dengan estimasi waktu selama 6 bulan, Pengujian, 

pengumpulan dan disain dari rancangan. Adapun alat dan 

bahan yang digunakan adalah sebagai berikut. Alat yang 

digunakan adalah Komputer / Laptop yang berfungsi untuk 

pemproraman dan membuat aplikasi IoT, multimeter, sumber 

tegangan DC, tang Potong, obeng +/- dll. 

Untuk bahan yang digunakan sensor modul Modul  

KEYES HY- M-302, Arduino Uno , Node ESP 8266, LCD 

Aktuator ( Motor DC, motor servo, solenoid valve dll) 

A. Blok Diagram dan Disain Alat 

Blok diagram perancangan alat ditunjukkan pada 

Gambar 5. 

 

 

 
Gambar 5. Blok diagram perancangan alat ajar praktikum sensor dan 

aktuator 

 

Pada Gambar 5 yang merupakan blok diagram dari 

perancangan alat yang terdiri dari , 

1. Sensor/data input 

2. Microcontroller Node MCU ESP8266 

3. Komunikasi IoT 

4. Server IoT  

5. Aktuator  

6. Display 

Penelitian ini merupakan perancangan dan pembuatan 

sehingga masing – masing bagian pada blok diagram hanya 

perlu diuji untuk dapat beroperasi dengan baik.  Berikut 

merupakan penjelasan dari masing – masing blok diagram 

pada Gambar 5.,  

• Sensor / Data input merupak modul yang berisi 

sensor – sensor seperti yang sudah dijelaskan 

sebelumnya pada BAB II, yaitu keyes – H M302, 

yang terdiri dari sensor LM 35, sensor DHT 11, 

microswitch sebagai input, buzzer, trimpot, LDR ( 

light emiting diode), dll 

• NodeMCU3 ESP8266 adalah salah satu perangkat 

mikrokontroller yang digunakan untuk 

mengendalikan perangkat IoT. Modul ini juga 

sebagai komunikasi dengan internet melalu WiFi 

serta dapat sebagai input dan output untuk memonitor 

sensor dan actuator pada alat ajar ini. 

• Komunikasi Iot, NodeMCU ESP8266 memiliki fitur 

Wi-Fi yang memungkinkan komunikasi IoT untuk 

mengirimkan data sensor ke server IoT atau 

menerima perintah dari perangkat pengguna melalui 

internet. Ada beberapa protokol dan platform yang 

dapat digunakan untuk komunikasi IoT 

• Server IoT berfungsi sebagai pusat pengumpulan, 

pemrosesan, dan visualisasi data yang diterima dari 

ESP8266. Server ini juga dapat memberikan perintah 

kembali ke ESP8266 untuk mengontrol aktuator 

berdasarkan hasil analisis data. Platform server IoT 

yang bisa digunakan meliputi: 

✓ Blynk Cloud: Memungkinkan kontrol 

perangkat melalui aplikasi dengan interface 

yang sederhana. Platform IoT berbasis cloud 

yang memungkinkan kontrol dan pemantauan 

perangkat melalui aplikasi seluler. Dengan 

Blynk, NodeMCUESP8266 dapat dikendalikan 

atau diotomatisasi dari jarak jauh melalui 

aplikasi 

✓ MQTT (Message Queuing Telemetry 

Transport): Protokol pesan yang ringan dan 

efisien yang digunakan dalam aplikasi IoT 

untuk komunikasi real-time antara perangkat. 

NodeMCUESP8266 dapat menggunakan 

MQTT untuk mengirim data sensor ke broker 

MQTT atau menerima perintah untuk 

mengontrol aktuator. MQTT Broker: Seperti 

Mosquitto, digunakan untuk pengiriman pesan 

antara perangkat IoT secara real-time. 

✓ ThingSpeak: Digunakan untuk menampilkan 

data dalam grafik, serta dapat memberikan 

analisis berbasis data yang dikirimkan dari 

NodeMCU32. ThingSpeak juga merupakan  

Platform IoT yang menyediakan fitur analisis 

data dan visualisasi. Data dari sensor yang 

dikumpulkan oleh ESP8266 dapat dikirim ke 

ThingSpeak untuk dianalisis atau 

divisualisasikan dalam bentuk grafik. 

B. Disain dan Perancangan Alat. 

Penggunaan aplikasi 3D menggunakan tinkercad.com 

untuk mendisain awal dari alat ajar praktikum sensor dan 

actuator seperti pada Gambar 6.  

 

 
Gambar 6. Disain alat ajar praktikum sensor dan aktuator 

 

Gambar 6. merupakan disain alat ajar praktikum yang terdiri 

dari modul sensor, driver actuator, project board, Arduino dan 

NodeMCU32. Disain menggunakan tinkercad.com, 
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merupakan aplikasi online yang dapat membuat aplikasi disain 

3D untuk alat maupun komponen – komponen yang 

digunakan. Rancangan dan tata letak seperti pada Gambar 7. 

 

 
Gambar 7. Tata letak alat ajar 

 

IV. HASIL DAN PEMBAHASAN 

 

Eksperimen dan analisis dari implementasi alat ajar 

sensor dan actuator berbasis Internet of Things (IoT) yang 

telah dikembangkan. Dilakukam pengujian dari sensor – 

sensor dan actuator yang terdapat pada alat ajar atau trainer 

berikut ini,  

 

A. Pengujian Sensor DHT dengan Aplikasi Thingspeak 

Pengujian alat ajar ini dapat dilakukan dengan aplikasi 

IoT , misalnya seperti thingspeak, yang merupakan aplikasi 

Untuk menghubungkan sensor DHT11 dengan NodeMCU dan 

memonitor data suhu dan kelembaban di ThingSpeak, pada 

modul ajar terdapat sensor DHT11, untuk menguji sensor ini 

bekerja dengan baik maka akan dilakukan pengujian dengan 

menggunakan NodeMcuESP 8266, untuk mengujinya 

disiapkan sebagai berikut , komponen yang diperlukan: 

1. NodeMCU (ESP8266) 

2. Modul Sensor DHT11** 

3. Kabel jumper 

Koneksi DHT11 ke NodeMCU, seperti pada Tabel 1. 
 

 

TABEL 1 

TABEL KONEKSI DHT DAN NODEMCU 

 
No NodeMCU8266 Modul DHT 

11 
   

1 VCC ( 3,3V) VCC    

2 GND GND    

3 D4 Data    

 

Pada Tabel 1, hubungan dari data DHT11 bisa saja 

menggunakan PIN Node Mcu dari data D1-D8, tapi pada 

pengujian ini menggunakan D4, sebagai input dari sensor 

DHT11. Kemudian Langkah selanjutnya adalah koneksi 

menggunakan Aplikasi ThingSpeak.   

 

Langkah – Langkah menggunakan Akun dan Channel 

ThingSpeak: 

1. Buka browser ,ThingSpeak (https://thingspeak.com) 

jika belum memiliki buat channel  baru di ThingSpeak: 

2. Masukkan nama untuk channel dan tambahkan dua 

"Field" untuk **Suhu** dan Kelembaban 

3. Catat API Key dari channel yang dibuat, Anda akan 

memerlukan Write API Key untuk mengirim data. 

Langkah instalasi Library di Arduino IDE : 

1. Instal library DHT: 

2. Buka Arduino IDE, klik "Sketch" > "Include Library" > 

"Manage Libraries". 

3. Masukan DHT sensor library, dari Adafruit dan instal. 

4. Juga instal library Adafruit Unified Sensor jika diminta. 

5. Instal library ESP8266, buka "File" > "Preferences" dan 

tambahkan URL board ESP8266 di "Additional Board 

Manager URLs" 

http://arduino.esp8266.com/stable/package_esp8266co

m_index.json 

6. Kemudian buka "Tools" > "Board" > "Boards 

Manager" dan cari ESP8266   untuk menginstalnya. 

 

Kode program NodeMCU untuk DHT11 dan 

ThingSpeak: Berikut adalah contoh kode untuk membaca suhu 

dan kelembaban dari DHT11 dan mengirimkannya ke 

ThingSpeak : 

 

 

#include <ESP8266WiFi.h> 
#include <DHT.h> 
// Pengaturan WiFi 
const char* ssid = "Nama_WiFi_Anda"; 
const char* password = "Password_WiFi_Anda"; 
// API Key ThingSpeak 
const char* apiKey = "API_KEY_THINGSPEAK"; 
// Pengaturan DHT11 
#define DHTPIN D4     // Pin D4 pada NodeMCU untuk 
data DHT11 
#define DHTTYPE DHT11 // Gunakan sensor DHT11 
DHT dht(DHTPIN, DHTTYPE); 
// Pengaturan server ThingSpeak 
const char* server = "api.thingspeak.com"; 
WiFiClient client; 
void setup() { 
  Serial.begin(115200); 
  delay(10); 
  // Inisialisasi DHT11 
  dht.begin(); 
  // Koneksi ke WiFi 
  Serial.println(); 
  Serial.println(); 
  Serial.print("Menghubungkan ke "); 
  Serial.println(ssid); 
  WiFi.begin(ssid, password); 
  while (WiFi.status() != WL_CONNECTED) { 
    delay(500); 
    Serial.print("."); 
  } 
    Serial.println(""); 
  Serial.println("WiFi terhubung"); 
} 
void loop() { 
  // Membaca suhu dan kelembaban 
  float h = dht.readHumidity(); 
  float t = dht.readTemperature(); // Celcius 
  // Memeriksa apakah pembacaan berhasil 
  if (isnan(h) || isnan(t)) { 
    Serial.println("Gagal membaca dari sensor 
DHT11"); 
    return; 
  } 
  //Menampilkan data di Serial Monitor 
  Serial.print("Suhu: "); 
  Serial.print(t); 
  Serial.print(" °C  "); 
  Serial.print("Kelembaban: "); 
  Serial.print(h); 
  Serial.println(" %"); 
  // Koneksi ke ThingSpeak 
  if (client.connect(server, 80)) { 
    String postStr = "api_key=" + String(apiKey) + 
"&field1=" + String(t) + "&field2=" + String(h); 
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Penjelasan Kode : 

• WiFi Connection: Kode atas menggunakan WiFi untuk 

menghubungkan NodeMCU ke jaringan. 

• DHT11: Sensor DHT11 dihubungka n ke pin D4, dan 

suhu serta kelembaban dibaca. 

• ThingSpeak API:  Data suhu dan kelembaban dikirim ke 

ThingSpeak menggunakan `Write API Key`. 

• Delay:  Data dikirim setiap 20 detik (disesuaikan dengan 

limit ThingSpeak). 

 

Langkah mengunggah kode ke NodeMCU adalah 

sebagai berikut: 

1. Hubungkan NodeMCU ke komputer menggunakan 

kabel USB. 

2. Pilih NodeMCU 1.0 (ESP-12E Module), sebagai 

board di Arduino IDE. 

3. Pilih port pada pengujian menggunakan port USB 

com13 kemudian  dan unggah kode. 

 

Untuk mengamati data di Thingspeak, setelah kode 

diunggah dan NodeMCU berjalan, buka dashboard 

ThingSpeak untuk melihat grafik suhu dan kelembaban yang 

dikirim oleh NodeMCU. Maka akan tampak seperti pada 

Gambar 8. 

 

 
 

Gambar 8. Hasil koneksi dari alat ajar dengan aplikasi IoT 

Untuk menguji sensor, solder dipanaskan dan diletakkan di 

dekat sensor, sehingga data keluaran sensor DHT11 berubah 

seperti pada Gambar 9. 

 

 
Gambar 9.. Sensor DHT11 setelah dipanaskan suhu meningkat 

 

B. Pengujian Aktuator Relay Menggunakan Aplikasi Blynk 

Sebagai Sistem Kendali  

Kemudian untuk menguji perangkat lainnya digunakan 

relay sebagai aktuator dan juga LED sebagai indikator yang 

juga merupakan aktuator karena berfungsi sebagai output. 

Untuk mengontrol relay menggunakan NodeMCU (ESP8266) 

dengan aplikasi Blynk, siapkan kabel – kabel jumper untuk 

menghubungkan relay dengan input pada NodeMCUESP8266 

yang terdapat pada modul ajar. Koneksi modul ajar dengan 

relay adalah seperti pada Gambar 10. 

 

 
Gambar 10. Koneksi NodeMCU dengan relay 

 

Menghubungkan VCC pada relay pada sumber tegangan 5V 

kemudian GND pada GND, dan input relay pada pin D5 pada 

ESP8266. Kemudian setelah terhubung buat kode program 

pada IDE Arduino seperti pada langkah sebelumnya. 

Kemudian setelah terhubung buat visual pada aplikasi Blynk 

pada handphone atau di website Blynk.com, dengan 

menggunakan akun yang sebelumnya sudah didaftakan. 

Seperti pada langkah – langkah berikut 

1. Langkah – Langkah membuat aplikasi kendali relay 

menggunakan relay  

- Install aplikasi Blynk dari Google Play Store atau 

Apple App Store. 

- Buat akun  jika belum memilikinya. 

- Buat proyek Baru : Pilih ESP8266 sebagai perangkat 

(Device). 

  } 
  //Menampilkan data di Serial Monitor 
  Serial.print("Suhu: "); 
  Serial.print(t); 
  Serial.print(" °C  "); 
  Serial.print("Kelembaban: "); 
  Serial.print(h); 
  Serial.println(" %"); 
  // Koneksi ke ThingSpeak 
  if (client.connect(server, 80)) { 
    String postStr = "api_key=" + String(apiKey) + 
"&field1=" + String(t) + "&field2=" + String(h); 
    client.println("POST /update HTTP/1.1"); 
    client.println("Host: api.thingspeak.com"); 
    client.println("Connection: close"); 
    client.println("Content-Type: application/x-
www-form-urlencoded"); 
    client.println("Content-Length: " + 
String(postStr.length())); 
    client.println(); 
    client.println(postStr); 
  } 
    client.stop(); 
  // Tunggu 20 detik sebelum mengirim data lagi 
  delay(20000);} 
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- Pilih WiFi sebagai koneksi. 

- Ambil "Auth Token" , ini akan dikirim ke email  atau 

yang terdapat pada metadata pada aplikasi blynk . 

2. Instal Library Blynk di Arduino IDE 

- Buka  Arduino IDE  dan pilih "Sketch" > "Include 

Library" > "Manage Libraries". 

- Cari  Blynk  dan instal  Blynk Library. 

3. Contoh Kode untuk Kontrol Relay dengan Blynk** 

 
 

Kemudian membuat layout pada aplikasi Blynk seperti pada 

Gambar 11. 

 

 
Gambar 11. Tampilan Blynk ON OFF Relay  

 

Gambar 11 merupakan contoh tampilan untuk tampilan 

aplikasi Blynk untuk mengendalikan ON OFF relay, di mana 

relay ini berfungsi juga sebagai otomatis yang dapat 

dikendalikan menggunakan Aplikasi IoT dengan Blynk, 

kemudian tampilan jika dikendalikan seperti pada Gambar 12. 

 
Gambar 12. Tampilan Blynk mengendalikan relay saat bekerja 

 

Gambar 12 merupakan kontrol relay dari aplikasi Blynk 

setelah NodeMCU terhubung ke Blynk melalui WiFi, buka 

aplikasi Blynk. 

- Tekan tombol yang sudah atur di aplikasi untuk 

mengontrol relay (nyala/mati). 

- Pastikan WiFi memiliki koneksi yang stabil. 

- Anda dapat mengubah pin relay dan virtual pin 

sesuai kebutuhan. 

- Jika relay bekerja secara terbalik (HIGH = mati, 

LOW = nyala), bisa menukar logika di 

“digitalWrite()”. 

Dari hasil pengujian meggunakan relay ini, pada saat 

aplikasi di tekan tombol ON dan OFF relay menyala sesuai 

dengan program yang telah dibuat. Berikutnya dilakukan 

pengujian untuk sensor DHT 11, seperti tampak pada gambar 

aplikasi ThingSpeak menunjukan suhu ruang 29o C dan 

kelembaban 67%. Kemudian dilakukan pengujian dengan 

menggunakan solder untuk menaikan suhu pada sensor 

DHT11 terjadi kenaikan suhu mencapai 40oC, dan kelembaban 

32%.  

Dalam pengujian yang perlu diperhatikan adalah 

pengawatan atau koneksi dari sensor atau aktuator yang akan 

di gunakan untuk praktikum, sehingga pengujian dapat bekerja 

sesuai dengan program yang telah dibuat. 

Alat ajar sensor dan aktuator ini, terdiri dari modul yaitu  

sensor HY-M302  yang langsung bisa dikoneksikan dengan 

modul aktuator, seperti relay, solenoid valve atau motor DC. 

 

V. KESIMPULAN 

 

Berdasarkan hasil pengujian yang dilakukan, sistem 

modul alat ajar berbasis NodeMCU ESP8266 yang terintegrasi 

dengan sensor dan aktuator berhasil berfungsi dengan baik. 

Sistem ini mampu mengumpulkan data dari sensor seperti 

suhu dan kelembaban secara real-time dan mengirimkannya ke 

platform IoT seperti ThingSpeak dan Blynk. Selain itu, modul 

ini juga dapat mengendalikan aktuator seperti relay dan motor 

servo melalui aplikasi berbasis internet. Hasil pengujian 

menunjukkan bahwa perangkat ini stabil dalam hal koneksi 

jaringan, pengiriman data, dan respon terhadap perintah dari 

aplikasi pengguna. Dengan demikian, alat ini dapat digunakan 

sebagai media pembelajaran praktikum yang efektif untuk 

mengenalkan konsep IoT dan otomasi kepada peserta didik. 

 

 

 

 

#define BLYNK_TEMPLATE_ID "Your Template ID" 
#define BLYNK_DEVICE_NAME "Your Device Name" 
#define BLYNK_AUTH_TOKEN "Your Auth Token" 
#include <ESP8266WiFi.h> 
#include <BlynkSimpleEsp8266.h> 
char auth[] = "YourAuthToken"; 
// WiFi credentials 
char ssid[] = "namawifi"; 
char pass[] = "PasswordWiFi"; 
// Pin kontrol relay 
int relayPin = D5;  // Sesuaikan dengan pin yang 
Anda gunakan 
void setup() 
{ 
  // Inisialisasi koneksi ke Blynk 
  Blynk.begin(auth, ssid, pass); 
  // Inisialisasi pin relay sebagai output 
  pinMode(relayPin, OUTPUT); 
  // Matikan relay (LOW = off, HIGH = on untuk 
kebanyakan modul relay) 
  digitalWrite(relayPin, LOW); 
} 
void loop() 
{ 
  // Jalankan Blynk 
  Blynk.run();} 
 
// Widget Blynk (Tombol) untuk mengontrol relay 
BLYNK_WRITE(V1) 
{ 
  int buttonState = param.asInt(); 
  if (buttonState == 1) { 
    digitalWrite(relayPin, HIGH); // Relay ON 
  } else { 
    digitalWrite(relayPin, LOW);  // Relay OFF }} 
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